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Important User Information

Read this document and the documents listed in the additional resources section about installation, configuration, and 
operation of this equipment before you install, configure, operate, or maintain this product. Users are required to 
familiarize themselves with installation and wiring instructions in addition to requirements of all applicable codes, laws, 
and standards.

Activities including installation, adjustments, putting into service, use, assembly, disassembly, and maintenance are 
required to be carried out by suitably trained personnel in accordance with applicable code of practice.

If this equipment is used in a manner not specified by the manufacturer, the protection provided by the equipment may 
be impaired.

In no event will Rockwell Automation, Inc. be responsible or liable for indirect or consequential damages resulting from 
the use or application of this equipment.

The examples and diagrams in this manual are included solely for illustrative purposes. Because of the many variables and 
requirements associated with any particular installation, Rockwell Automation, Inc. cannot assume responsibility or 
liability for actual use based on the examples and diagrams.

No patent liability is assumed by Rockwell Automation, Inc. with respect to use of information, circuits, equipment, or 
software described in this manual.

Reproduction of the contents of this manual, in whole or in part, without written permission of Rockwell Automation, 
Inc., is prohibited.

Throughout this manual, when necessary, we use notes to make you aware of safety considerations.

Labels may also be on or inside the equipment to provide specific precautions.

WARNING: Identifies information about practices or circumstances that can cause an explosion in a hazardous 
environment, which may lead to personal injury or death, property damage, or economic loss.

ATTENTION: Identifies information about practices or circumstances that can lead to personal injury or death, property 
damage, or economic loss. Attentions help you identify a hazard, avoid a hazard, and recognize the consequence.

IMPORTANT Identifies information that is critical for successful application and understanding of the product.

SHOCK HAZARD: Labels may be on or inside the equipment, for example, a drive or motor, to alert people that dangerous 
voltage may be present.

BURN HAZARD: Labels may be on or inside the equipment, for example, a drive or motor, to alert people that surfaces may 
reach dangerous temperatures.

ARC FLASH HAZARD:  Labels may be on or inside the equipment, for example, a motor control center, to alert people to 
potential Arc Flash. Arc Flash will cause severe injury or death. Wear proper Personal Protective Equipment (PPE). Follow ALL 
Regulatory requirements for safe work practices and for Personal Protective Equipment (PPE).
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Preface

Product Description

The ClearPlot™ Basic plotter is used to produce marker cards for use on terminal blocks, wires, cables, and other 
industrial components. It's ideal for low- to medium-volume marking requirements.

About This Publication

The following publication provides a brief overview of how to install, operate, and maintain the ClearPlot Basic marking 
system.

Summary of Changes

This manual contains new and updated information as indicated in the following table.

Topic Page

Removed base plate from Accessories table. 7
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Notes:
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Chapter 1

Introduction

Check that you have received all items. Retain the specialized packaging for the plotter.

The following items are supplied as standard.
• ClearPlot™ Basic 
• Plot plate 
• Three stainless steel inlays
• Power supply with interchangeable adapter plug
• USB cable
• DVD with ClearTools™ software and product manuals

Table 1 - Accessories 

Item Cat. No. Description   

Disposable pen 1492-PLOTPEN25 Disposable ink pen with 0.25 mm (0.0098 in.) tip diameter 

Disposable pen 1492-PLOTPEN35 Disposable ink pen with 0.35 mm (0.014 in.) tip diameter 

Pen adapter 1492-PLOTADPT Pen adapter for use with Sharpie™ Ultra Fine Point Pen (recommended with font size 12 pt. and above)

Plot plate 1492-PLOTBSCPLT Plot plate for the plotter

Inlay (Qty: 3) 1492-PLOTINLAY Stainless steel inlay plates for plotter

Plotter software              — DVD of ClearTools Software

Single plate 1492-PLOTPLTA Single plate that is used with wire markers, Cat. Nos.: 1492-MW5-21, -MW6-21, and -MW7-21 (not included in plotter kit)

1492-PLOTPLTB Single plate that is used with group marker, Cat. No. 1492-GM5X30 (not included with plotter kit)

TIP The latest ClearTools software can be downloaded at: www.ab.com/industrialcontrols/products.  
Select Connection Devices > Terminal Blocks > Marking Solutions > X-Y Plotter Marking System > Software.

IMPORTANT Use only the listed accessories with the plotter. Use of other accessories can damage the plotter.
Rockwell Automation Publication 1492-QS004B-EN-P - November 2018 7
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Chapter 1   Introduction
Product Overview

Plotting Area

Pins for Holding 
Support Plates

Pins for Holding 
Support Plates

Clip Adapter to Hold 
Plotter Pen

Pen Holder Power Adapter

Plotting Arm Control Panel/Keys

 Plotter Pen 
Storage Location

USB Port
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Chapter 2

Plotter Setup

This chapter contains information on the plotter location, connections, software installation, and driver installation.

Location

A dry, dust-free room is the ideal environment for the plotter. If possible, do not install the device in a damp or dusty area. 
Do not expose the system to direct sunlight. Check that the connections on the device are accessible. Position the 
ClearPlot™ Basic firmly on the work surface where it is to be used, verifying it is level.

Confirm that the writing arm can move freely and is not obstructed by other objects.

Connections

Plug the device into a correctly installed power socket with the included power supply.

The power supply features a variable AC input voltage of 100...240V AC, 50/60Hz. Plug the connector from the output 
cable on the power supply into the back, right-hand side of the plotter.

Then hook up the device with the provided USB cable. The respective ports are on the top side of the plotter near the 
Allen-Bradley® product label.

Install the ClearTools Software

1. Load the ClearTools™ software DVD.

2. Click Software. 
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Chapter 2   Plotter Setup
3. Click ClearTools Software Installation.

4. Click Yes.

5. Click Next.

6. Accept the terms and click Next. 
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Plotter Setup   Chapter 2
7. Click Typical.

8. Click OK.

9. Click Install.

10. Click Finish.
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Chapter 2   Plotter Setup
Driver Installation

These instructions outline how to install the driver for your plotter with the psetup installation package. 
 
The package consists of the folder Psetup_..., which contains psetup.exe, the executable, and support folders and files for 
setup.

You have received this package on the DVD, together with a new machine, or have downloaded the package as a packed 
file from the Internet. If you have downloaded this file, be sure to unpack the package and store it locally on your personal 
computer.

The driver is compatible with the Windows versions 2000, XP, Vista, 7, 8, 8.1 and 10. Before starting the installation, 
read the detailed instructions for the corresponding operating system of your personal computer.

Vista and Windows 7 Driver Installation

To install the plotter driver for the Vista and Windows 7 operating system, follow these steps.

1. Connect the plotter to your computer.

2. Turn on the power (recommended).

3. Open the folder named Psetup.

4. Start the program psetup.exe.

If you have not signed in as an administrator, you are prompted for an administrator account and password. 
The Device Driver Installation Wizard dialog box appears.

5. Click next to begin the driver installation.

The message ‘Windows can’t verify the publisher of this driver software’ appears. 
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Plotter Setup   Chapter 2
6. Click ‘Install this driver software anyway’.

7. Click Finish to complete the driver pre-installation process.

If you do not switch on your plotter now, the driver installation is completed on first use.

Windows 8 and Windows 8.1 Driver Installation

To install the plotter driver for the Windows 8 and Windows 8.1 operating system, follow these steps.

1. Connect your plotter to your computer. 

2. Turn on the power (recommended).

3. Open the folder named Psetup.

4. Start the program psetup.exe.

If you have not signed in as an administrator, you are prompted for an administrator account and password.

The window that is shown appears giving you instructions for installing the driver. 

5. Click OK.

TIP If you have not switched on your plotter yet, it is best to do it now. When the plotter is switched on the first time, Windows 
completes the driver installation automatically. After completion, a taskbar bubble appears. 
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Chapter 2   Plotter Setup
6. Click Yes to restart immediately or No to continue the installation later.

To continue the installation, you must restart your computer and sign in as an administrator.

Upon restart, the menu Startup Settings appear.

7. Choose option 7: Disable driver signature enforcement by pressing the 7 or F7.

8. Sign in with your administrator account (the same account that is used when calling psetup.exe).

After signing in, the Device Driver Installation Wizard starts automatically.

9. Click Next to start the driver installation.
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Plotter Setup   Chapter 2
The following dialog box appears.

10. Click Install this driver software anyway.

11. Click Finish to complete the driver pre-installation process.

12. Check the progress of your installation by clicking the task bar bubble. 

The symbol and message window will disappear after the installation is completed.

If you do not switch on your plotter now, the driver installation is completed on first use.

TIP If you have not switched on your plotter yet, it is best to do it now. When the plotter is switched on the first time, Windows 
completes the driver installation automatically. After completion, a taskbar bubble notification appears. 
Rockwell Automation Publication 1492-QS004B-EN-P - November 2018 15



Chapter 2   Plotter Setup
To check the success of the installation, go to Devices and Printers under the control panel. Verify the plotter is in the list 
of printers.

Windows 10 Driver Installation

1. Connect your plotter to your computer and turn on the power (recommended).

2. Open the folder named Psetup_... and start the program psetup.exe.

3. If you have not signed in as an administrator, you are prompted for an administrator account and password.

4. The window that is shown appears giving you instructions for installing the driver (described here in detail). 

5. Click OK.

6. Click Yes to restart immediately or No to continue the installation later.

To continue the installation, you must restart your computer and sign in as an administrator.
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Plotter Setup   Chapter 2
Upon restart, the Startup Settings appear.

7. Choose the option: Disable driver signature enforcement by pressing 7 or F7.

8. Sign in with your administrator account (the same account that is used when calling psetup.exe). 

After signing in, the Device Driver Installation Wizard starts automatically.

9. Click Next to start the driver installation.

The following screen appears. 
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Chapter 2   Plotter Setup
10. Click Install this driver software anyway.

11. Click Finish to complete the driver pre-installation process.

12. Switch on the Plotter if you have not already.

Windows then completes the driver installation automatically without notice. It can take up to 30 seconds until the 
driver is ready for use. If you do not switch on your plotter now, the driver installation is completed on first use. In this 
case, switch on your plotter when the windows login is completed (or recycle the power of your plotter after signing in).

To check for a successful installation, follow these steps.

1. Go to Control Panel <Devices and Printers under the control panel, verify that your plotter is listed under 
printers.

If the driver installation was not successful or incomplete, the entry USB Printing Support is displayed in the category 
Unspecified of Devices and Printers. 

When the installation is still in progress, the icon is displayed with a clock beside it. 
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Windows XP Driver Installation

1. Log in as an administrator. 

2. Open the Folder Psetup.

3. Start the program psetup.exe.

A message window reminds you to keep the plotter switched off. 

4. Click OK to start the pre- installation.

During the installation of the plotter software, the following dialog box appears.

5. Click Continue Anyway.

When the pre-installation is finished, you are notified that you can now connect and switch on your plotting or 
engraving device. 

6. Click OK.
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Chapter 2   Plotter Setup
7. Connect the plotter to your computer and switch on. 

The Found New Hardware Wizard starts and the following dialog box appears.

8. Click No, not this time.

9. Click Next.

10. Click Install the software automatically (Recommended).

11. Click Next.
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Plotter Setup   Chapter 2
12. Click Continue Anyway.

13. Click Finish to complete the driver installation.

The plotter can now be used. You can sign in with your user account.

Windows 2000 Driver Installation

1. Sign in as an administrator. 

2. Open the Folder Psetup and start the program psetup.exe 

3. A message window reminds you to keep the plotter switched off. 

4. Click OK to start the pre- installation.

During the installation of the plotter software, the following dialog box appears.

5. Click Yes.

When the pre-installation is finished, you are notified that you can now connect and switch on your plotting or 
engraving device. 
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Chapter 2   Plotter Setup
6. Click OK. 

7. Connect the plotter to your computer and switch it on. 

The Digital Signature Not Found dialog box appears again.

8. Click Yes.

The plotter can now be used. You can sign in with your normal user account.
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Chapter 3

Operation

Once you have installed the ClearPlot™ Basic and connected the power supply and USB cable, you can switch on the 
plotter.

Control Panel

All settings and commands are entered using the control panel.  

IMPORTANT Before switching the device on, check that there are no objects on the writing/plotting area that inhibit the writing arm from 
moving freely.

Plotter ON/OFF Status Indicator

Internal Buffer Loaded Status Indicator

Plotter Stop Mode Status Indicator

Switch Plotter ON/OFF 

Delete Data Downloaded from 
Personal Computer

Turn OFF the Beep Reminder Signal to 
Recap and Store the Plotter Pen

Pause or Stop Plotter Activity
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Chapter 3   Operation
ON/OFF Buttons

The ON/OFF buttons are used to activate and deactivate the device. When the plotter is switched on, the writing arm 
moves to the top right-hand corner of the labeling area and auto calibration takes place. The green light comes on when 
the system is ready for use and to receive data from the personal computer.

Clear Buffer

If the ClearPlot Basic contains data the yellow light comes on. You can delete this data by pressing the Clear buffer key. 
To clear the buffer, the system must be in stop mode (red light on).

Stop-key

If the stop-key is activated while the plotter is in action, the job pauses immediately and the pen holder moves into the 
top right-hand corner. The red light signals the interruption. Pressing the key again calibrates the writing arm and the 
plotter continues with the job. The red light goes out.

Beep Off Key

After completion of the print job, an acoustic signal (beep) notifies the user to take the pen out of the pen holder and 
recap. The signal repeats continuously after 20 seconds and can be turned off by using the beep off key.

To turn off the signal first power of the plotter by selecting of off button. Next, press Clear Buffer and beep off together 
and press ON to start the plotter.

To reactivate the signal, use the same sequence.

Insert the Plotter Pen Into the Pen Holder

Before using the ClearPlot Basic, insert the plotter pen with the desired tip width into the clip adapter of the pen holder.

The plotter recalibrates before first plotting.

Place the Plates on the Plotter

There are four pin stops on the plotting area where up to three different support plates can be loaded. Different support 
plates are available depending on the size of the marking elements.

IMPORTANT The pen clogs and dries up if it remains uncapped in the pen holder

IMPORTANT Before starting the plot, select the pen with the desired tip width and make sure to prime the pen on a plastic surface. Insert the 
pen directly into the pen holder.
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Install the Metal Inlays

1. Align the number on the inlay with the notched locater on the base plate.

2. Slide right side of marker card under ledge on plotter plate.

3. Line-up first notch on the left side of the marker card to the notch on the plotter plate. 

4. Press the left side on the marker card down on to the plotter plates. 

Table 2 - Inlay Spacer Requirement Using Special Plate, 1492-PLOTPLTB

Place the Elements in the Support Plates

Choose the appropriate support plate for the elements to be labeled and insert the elements carefully into the support 
plate. You can also add the elements first and then place the support plate on the plotter.

Inlay Installation onto Plate
 Marker Card Installation onto Plate

Marker Card Inlay

1492-MW5-21 Inlay is needed

1492-MW6-21 No inlay needed

1492-MW7-21 No inlay needed

Marker Card Inlay

1492-GM5X30 No inlay needed

IMPORTANT The plotter always recalibrates before first plotting.
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Chapter 3   Operation
Activate the Plotter with ClearTools Software

Introduction

This chapter describes the setup, activation, mapping/calibration of the plotter to the printed marker cards, and plotting 
options while using ClearTools™. 

Switch to Plot Mode

Before you can plot with ClearTools, the software must be put into Plot Mode 

1. Click the icon on the toolbar, or go to File and select Toggle Plot Mode 

IMPORTANT Plot mode is active when Plot Mode is written next to the version number or when the following icon in the toolbar 

appears depressed:
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Startup Options for Plot Mode

1. The display in Plot Mode can be configured with the Options window (select Tools > Options > Plotter).

Map to Plotter 

1. After you have filled out your card as desired, go to File→ Print.

2. Select the plotter (1492-PLOTBSC) in the Printer pull-down menu. 

3. Click Map on the print screen. 

The Map Printer dialog box appears.

4. Click ‘As ClearPlot Basic (1492-PLOTBSC)’

5. Click OK.

IMPORTANT Activate the Start in Plot Mode checkbox if Plot Mode is to be launched in the program after a restart, when opening an 
application-file or when creating a project. Pcard, the card must be calibrated and mapped to the plotter.

IMPORTANT Each time a new card is selected it needs to be mapped to the plotter
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Chapter 3   Operation
General Calibration

 To check the plotter calibration, plot a card with a row of Xs going vertically down the marker tags, and with a row going 
horizontally across the marker tags. 

– If the Xs are centered on all tags, do not change any calibration settings and move onto plotting your cards.
– If the Xs are not centered, follow these steps.

1. Go to File to Print and Click Calibration. 

2. Click Zero Points.   

3. Place a piece of tape over the engraved + on the upper left corner of the plotter; this is your ideal Zero Point.

4. Click Plot Zero Point and watch where on the tape the plotter draws a + in relation to the engraved one on the 
plotter.
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5.  If the plotted + is above or below the engraved one, adjust the Y setting, if it is to the right or left, adjust the 
X setting.

• Increasing X value: Moves the + to the right.
• Decreasing X value: Moves the + to the left.
• Increasing Y value: Moves the + up.
• Decreasing Y value: Moves the + down. 

6. Continue adjusting the settings until the Zero points match, then reprint the test card and determine if the 
calibration is correct.

Marker Type Adjustment
If you are satisfied with your calibration, move onto the Plotting section. If calibrating the Zero Point is not effective 
on a card type, follow these steps.

1. Choose File> Print> Calibration and Click Adjust Marker Type.

The Adjust Marker Type dialog box appears.

2. Verify that the plotter is selected under Options.

IMPORTANT Suggested increment of change: 5.0
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Chapter 3   Operation
3. Use the Offset X and Offset Y values to adjust the single cards calibration.

– Increase Offset X: Text moves down.
– Decrease Offset X: Text moves up.
– Increase Offset Y: Text moves left.
– Decrease Offset Y: Text moves right.

Plotting

1. To plot a card, fill out the card as desired.

2. From the File menu, choose Print.

3. Click Print. 

The MarkerCard Fixture dialog box appears.

IMPORTANT Suggested increment of change: 0.5 mm (0.002 in.). The directions are based on a vertical card as placed on the plotter.

The number next to the red 
bar (position 2 in this case), 
indicates the inlay position.

1 2 3

There are three frames 
for the cards
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4. Verify that the inlay is in the correct position and that the card is on the right frame. 

5. If they are all correct, click Continue Plotting.

Plotting Multiple Cards
Multiples of the same card and multiple different cards can both be plotted in the same print session. 

To plot multiples of the same card, follow these steps. 

1. To create multiple pages of a marker card, right-click the bottom tab strip in ClearTools and click Insert New 
Page. 

2. Fill the multiple pages as desired. Each page can be treated as another Marker Card.

3. From the File menu, choose Print.

4. Choose Single Pages and Check the desired label type page.
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Chapter 3   Operation
5. Click Print.

6. Verify that the inlay positions are correct.

7.  Click Continue Plotting.

IMPORTANT • If you do not want to print three marker cards, or wish to skip a frame, deselect the Use Frame checkbox that is located 
above each frame. Any frames that are not selected are not plotted. 

•  When plotting more than three cards in a plot job, multiple Marker Card Fixture windows appear. Click Continue Plotting on 
the first window. Do not select continue plotting on the second window until the first batch of marker cards are plotted and 
you have put new marker cards into the frames. 
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Plotting Multiple Different Cards 

To plot multiples of different cards, follow these steps.

1. In the Project Explorer window, right-click and select Insert New Marker Type to create multiple cards.

2. Fill the cards as desired.

3. From the File menu, choose Print.
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Chapter 3   Operation
All cards must be mapped to the plotter. To map cards that are all different to the plotter, follow these steps. 

1. Click a card.

2. Select the plotter from the pull-down menu.

3. Click Map.

4. Click Print.

5. Verify that the inlay positions are correct and that the marker cards are in the correct frame locations. 

6. Click Continue Plotting.
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Chapter 4

Troubleshooting and Maintenance

This chapter contains information on how to troubleshoot the plotter and perform routine maintenance.

Troubleshooting the Plotter

Table 3 lists the most common operating problems, probable causes, and steps to correct the problem. If you encounter a 
problem that is not listed in the table, contact Rockwell Automation® Technical Support at (440) 646-3434, options: 3, 2, 
4, 2, 5. 

Required Equipment

A voltmeter is required for verifying that the correct voltage is supplied to the plotter. The voltmeter is also required for 
verifying the correct communications cable configuration.

Table 3 - Troubleshooting 

Problem Probable Causes Corrective Actions

Plotter does not power up. Plotter is not plugged in.
Improper connection to the power source.

Verify that plotter is plugged in.
Verify 110/220V AC, 50/60 Hz voltage at power source.

No communications between plotter and 
computer.

Faulty communications cable.
Wrong COM or USB port is selected.
USB is plugged in upside down.

1. Check the cable connections.
2. Verify that cable is plugged into the COM or the USB port that is 

selected in the ClearTools™ software.
If steps 1 and 2 do not restore communications, follow these 
steps.

1. Turn off the plotter.
2. Disconnect the communications cable, 
3. Restart the computer.
4. Connect the communications cable.
5. Turn on the plotter.
6. Start the ClearTools software.

Plotter does not properly align text on markers. The Plotter is not calibrated correctly. Check that the plotter is calibrated as described in the ClearTools 
Software User Manual, publication 1492-UM009.

Marker text quality is poor. Defective marker pen or the pen is out of ink.
Incorrect inlay placement.
Plotting speed is too fast.

1. Replace the marker pen.
2. Check inlay installation, Refer to Install the Metal Inlays on 

page 25
3. Reduce plotting speed.

If steps 1…3 do not improve the text quality, contact technical 
support at (440) 646-3434.

For any other problems, call Technical Support at (440) 646-3434.
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Chapter 4   Troubleshooting and Maintenance
Plotter Maintenance

The plotter has several sliding surfaces. These surfaces do not require any lubrication. However, dust and lint can 
adversely affect plotter performance. Use a dust cover to keep the plotter as clean as possible.

Cleaning Plotter

If necessary, clean the plotter with a dry, lint-free cloth, or a mild cleaning solution. Do not use abrasives.

Plotter Pen Maintenance

The plotter pen (catalog numbers 1492-PLOTPEN25 and 1492-PLOTPEN35) must be 
removed from pen holder on the plotter, capped tightly and stored in the provided pen holder 
or the holder station on the plotter.

EEE Yönetmeliğine Uygundur. (In Conformity with the EEE Regulation).

IMPORTANT Do not use harsh products to clean the plotter. Never lubricate the mechanical parts of the plotter.

At the end of its life, this equipment should be collected separately from any unsorted municipal waste.
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Chapter 5

Specifications

Technical and Environmental Specifications
Attribute 1492-PLOTBSC

Plotting area, max 273 mm x 305 mm (10.8 x 12.0 in.)

Plotting speed with pen, max 40 mm/s (1.575 in./s)

Plotter pens Cat. Nos. 1492-PLOTPEN25 and 1492-PLOTPEN35

Ports USB Level 2.0

Power supply Description Separate power supply with interchangeable adapter plug

Input voltage 100…240V AC, 50/60 Hz

Input current, max 0.7 A

Output voltage 24V DC

Output current, max 1.25 A 

Temperature, operating 10 …35 °C (50…95 °F), 35…75 % relative humidity

Temperature, nonoperating -10…+50 °C (14…122 °F), 10…90 % relative humidity

Safety certificate EN 60950-1

Interference safety compliance EN 55022 B, EN 61000-4-2, EN 61000-4-3, EN 61000-4-4, EN 61000-4-5, EN 61000-4-6

Dimensions 470 x 480 x 155 mm (18.5 x 18.9 x 6.1 in.)

Weight 6.3 kg (13.9 lb)
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Instructions for Repackaging the Plotter

Corner Pieces

Corner Pieces

Center Piece Covers the Y-Arm

Inside the Box Inside the Box, CompleteAccessory Box
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Additional Resources

These documents contain additional information concerning related products from Rockwell Automation.

You can view or download publications at 
http://www.rockwellautomation.com/global/literature-library/overview.page. To order paper copies of technical documentation, 
contact your local Allen-Bradley distributor or Rockwell Automation sales representative.

Resource Description

ClearTools Software User Manual, publication 1492-UM009 Provides installation and user information for ClearTools™ Software

Product Certifications website, rok.auto/certifications. Provides declarations of conformity, certificates, and other certification details.

https://www.rockwellautomation.com/global/detail.page?pagetitle=Product-Certifications&content_type=tech_data&docid=de1cc7d81606981b0f214fed1137f539
http://literature.rockwellautomation.com/idc/groups/literature/documents/um/1492-um009_-en-p.pdf
http://literature.rockwellautomation.com/idc/groups/literature/documents/um/1492-um009_-en-p.pdf
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Rockwell Automation Support
Use the following resources to access support information.

Documentation Feedback
Your comments will help us serve your documentation needs better. If you have any suggestions on how to improve this document, complete the 
How Are We Doing? form at http://literature.rockwellautomation.com/idc/groups/literature/documents/du/ra-du002_-en-e.pdf.

Technical Support Center Knowledgebase Articles, How-to Videos, FAQs, Chat, User 
Forums, and Product Notification Updates. https://rockwellautomation.custhelp.com/ 

Local Technical Support Phone Numbers Locate the phone number for your country. http://www.rockwellautomation.com/global/support/get-support-now.page 

Direct Dial Codes Find the Direct Dial Code for your product. Use the code to 
route your call directly to a technical support engineer. http://www.rockwellautomation.com/global/support/direct-dial.page 

Literature Library Installation Instructions, Manuals, Brochures, and 
Technical Data. http://www.rockwellautomation.com/global/literature-library/overview.page 

Product Compatibility and Download 
Center (PCDC)

Get help determining how products interact, check 
features and capabilities, and find associated firmware. http://www.rockwellautomation.com/global/support/pcdc.page 

Rockwell Otomasyon Ticaret A.Ş., Kar Plaza İş Merkezi E Blok Kat:6 34752 İçerenköy, İstanbul, Tel: +90 (216) 5698400

Allen-Bradley, ClearPlot, ClearTools, Rockwell Automation, and Rockwell Software are trademarks of Rockwell Automation, Inc.
Trademarks not belonging to Rockwell Automation are property of their respective companies.

Rockwell Automation maintains current product environmental information on its website at http://www.rockwellautomation.com/rockwellautomation/about-us/sustainability-ethics/product-environmental-compliance.page.

http://www.rockwellautomation.com/rockwellautomation/about-us/sustainability-ethics/product-environmental-compliance.page
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